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About this Guide
®

The images and topics contained in this guide are not representative of every GlobalLink product installation.
Each GlobalLink product installation is configured to meet the needs of the intended users, who may or may not
require certain features and options. Therefore, the features and options covered in this guide may differ from
those available on your GlobalLink product installation.

Conventions
CONVENTIONS

Typographical
The following table explains the typographical conventions used in this guide.
Bold

User interface controls, commands, and keywords in body text.

italic

Represents an input field where user input is expected.

<…>

Generic parameters that must be replaced by specific code or text.

CONVENTIONS

Icons
The following table explains the icon conventions used in this guide.
Note:
This icon designates a note or helpful suggestion or reference relating to the surrounding text.
Best Practice:
This icon designates a suggestion for best practice relating to the surrounding text.
Alert:
This icon designates a warning or alert relating to the surrounding text. In this situation, the user
should exercise caution to avoid an undesirable result.
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1. About GlobalLink
GlobalLink is the undisputed leader for integration in translation management with hundreds of clients seamlessly
submitting and receiving global content from CMS, e-commerce, PIM, DAM and database systems.

Globalization Management Suite
The GlobalLink Globalization Management Suite (GMS) is a modular set of translation technology products that
provide enterprise solutions for organizations. It consists of the following server components:

•
•
•
•
•
•

GlobalLink Project Director—An automated translation workflow system that leverages and
communicates with the other GlobalLink products through a published Web services API
GlobalLink TM Server—A robust, scalable server-based translation memory solution
GlobalLink Term Manager—A web-based terminology management tool that allows any translation
manager to modify, review, search, or delete existing terms
GlobalLink TransStudio Online—A web-based translation tool that offers translators instant access to
translation memories and terminology lists
GlobalLink TransStudio Review—A web-based translation review tool with an intuitive user interface that
allows translated content to be reviewed quickly and effectively
GlobalLink Translation & Review Portal—A web-based, collaborative application that streamlines the
linguistic review process

TransStudio Review
TransStudio Review is a web-based review and editing tool you can access through GlobalLink Project Director.
Opening the files in Project Director (PD) launches a new browser tab for working on the files in TransStudio
Review. When the software leverages the files against a designated Translation Memory (TM) and terminology
(glossary), TransStudio Review displays any existing TM matches and glossary terms.

•
•
•
•
•
•
•

Server-based TM—Share translation memory (TM) content with approved resources in real time,
dramatically improving reuse of approved translations
Intuitive interface—Map keystrokes and shortcuts, resulting in rapid user adoption
TM Compatibility—Simple integration with legacy TM systems
Format flexibility—Industry-leading portfolio of supported TXML and TXLF file formats or parse to create
your own
Power validation—Detect non-linguistic errors, such as real-time glossary validation with Transcheck
Zero compromises—Work on your web browser with all the power of a desktop TM tool
Platform independent—Work in any operating system with browser-based tool
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2. Get Started
This section provides the basic information to get you started with TransStudio Review, which you access through
GlobalLink Project Director (PD).
TransStudio Review launches in a new browser window from Project Director.

System Requirements
Supported Web Browsers

Microsoft Internet Explorer (IE) 11 and Google Chrome

Minimum Internet Connection Speed

2 Mbps download / 1 Mbps upload

Minimum Screen Resolution

1366 x 768 pixels

System Access
As part of your welcome to Project Director, you will receive an email that contains your username, initial
password, and a the Project Director URL. If you have not received this, please contact your GlobalLink
representative.
SYSTEM ACCESS

System Prerequisites
TransStudio Review uses pop-ups to provide users with their workspace. Most browsers block pop-ups by default,
so you will need to disable pop-up blockers or add TransStudio Review to the browser's list of Allowed Sites or
Exceptions. If you are unsure about how to allow pop-ups, refer to your browser's help section.
Check your browser settings if a file fails to open in a new browser pop-up window.

SYSTEM ACCESS

Log In
Have your username, password, and the Project Director URL ready before you log in to Project Director.
To log in and log out of Project Director:
1. Using a supported web browser, go to the Project Director URL provided by the GlobalLink representative.
2. Enter your username and password at the log in screen.
3. Click Log in.
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2. Get Started

®

GlobalLink TransStudio Review

You are logged in to Project Director.

•
•

If you are logging in for the first time using a temporary password, update your password when
prompted.
If you cannot remember your password, click Forgot your Password? and enter your
username in the Reset Password dialog, then click Reset Password. Project Director sends a
new password to your email address.

4. After you've finished your tasks, log out of Project Director.
a) Click the down arrow next to your username.
b) Click Logout from the drop-down list.
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3. Basic PD Tasks
This section provides quick access to those Project Director (PD) tasks you will perform as a regular part of your
role. For the purposes of this guide, basic tasks are those tasks absolutely required to move submissions to
completion. Submissions can consist not only of source files, but also reference files, comments, and instructions
and follow a specific workflow from the time they are created until they are completed.

•
•

A workflow consists of an unbroken path of workflow phases connected by transitions between a start and
end point.
At minimum, a project most often consists of a submission, claim of the content, work on the file(s), and
completion of the submission that follows an assigned workflow.

Some workflow phases within a workflow, such as Translation, Review, and dtpReview, might have a slightly
different name, since this is configuration-dependent. For the purposes of this document, any workflow phase
where the name might vary is identified with <workflow phase>.

Claim a Submission
Before you can access and work on your files, you will need to log in to Project Director (PD) and use the PD
dashboard. Before working on a submission file, you must claim it and work on it online.
To modify how you receive PD notifications about your submission files, refer to PD online help.
To claim a submission:
1. In the Available folder, select a submission and then the respective workflow phase tab.

2. Click Claim Translation or Claim Review.

3. In the Claim Submission dialog, select language batches and then click Claim to claim files and process
them later or click Claim and get files to launch the File Management dialog (FMD) and begin work
immediately.
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3. Basic PD Tasks

®

GlobalLink TransStudio Review

4. In the File Management dialog, select the batch or file and click Open.
5. Work on the submission files, marking each file as complete when you are finished with it.
6. Click Upload to upload the completed files.
The TransStudio web browser closes. TransStudio notifies you if the upload was successful or if there was an
upload error in the resulting dialog.

Work on Files Online
TransStudio Online allows you to translate submission files in a browser, without installing any extra application or
browser plug-in. TransStudio Review is the companion application that supports review tasks.
To work on files online:
1. In the Inbox folder, select a submission.
2. Click Get/Deliver <workflow phase>. In the example below, you would click Get/Deliver Translation from
the Translation tab.
For some users, the workflow phase in this task might have a name other than Translation. If so, the
name of the tab and the name of its action buttons will match the name of the workflow phase.
3. In the File Management dialog, select the batches or files to work on and click Open.
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GlobalLink TransStudio Online (TSO) or TransStudio Review (TSR) opens as a new tab in the browser.
4. Work on the files in TSO or TSR and mark them as completed afterwards.
The TSO or TSR browser tab closes and a dialog indicates if the files have uploaded successfully.
5. Click Complete all in the File Management dialog to move all completed files to the next workflow phase.
Once you click Complete all, the completed files move to the next workflow phase and are no longer
accessible. This step cannot be undone.
6. (Optional) To review the results after completing files in TSO or TSR, click Open Upload Report, then
proceed to Complete all.
The selected files are complete and move to the next workflow phase.

Unclaim a Workflow Phase
If you have claimed one or more workflow phases but you are unable to complete the assigned task, you should
unclaim that workflow phase to allow other users to complete the task.
To unclaim a workflow phase:
1. In the Inbox folder, select the appropriate workflow phase tab.
2. Click Unclaim <workflow phase>. In the example below, you would click Unclaim Translation from the
Translation tab.
For some users, the workflow phase in this task might have a name other than Translation. If so, the
name of the tab and the name of its action buttons will match the name of the workflow phase.
3. On the Unclaim Submission dialog, select the language batches you want to unclaim.
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3. Basic PD Tasks
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4. Click Unclaim.
A warning message requests confirmation that you want to continue.
5. Click Yes.
The workflow phase is now available for other users to claim.

•
•
•

If you unclaim a target language, all batches for that target language are available for other
vendors to claim.
If you unclaim a batch, all files in the batch are available for other vendors to claim.
If you unclaim a vendor, then all the languages and batches claimed by that vendor are
available for other vendors to claim.
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4. Explore the User Interface
TransStudio Review allows users to coordinate and manage the review process through an intuitive user
interface. Once you open the submission in Project Director (PD), you can open the files using TransStudio
Online and begin your review.
The view that TransStudio Review opens depends on your selection in PD. If you have selected a submission
with multiple files, the result is the Current Project view. If you have selected a single submission file, the result is
the TXLF Editor view. You can move between views using the TransStudio Review drop-down menu.

Current Project View
The Current Project view is for projects that contain multiple files. Double-click a file from the list of TXLF files
ready for translation to open the TXLF Editor view and access source and target segments.
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4. Explore the User Interface
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Item

Action

TSR Menu

Access the Current Project or TXLF Editor views and user preferences

Menu Tab

Access the various tools of the application

Action Button

Perform a specific task

Action Bar

Access all action buttons associated with a specific tab

Language Pair

Access the file list associated with a specific source and target language pair

File Filter

Create filter criteria for searching the file list

File List

Access a specific file within the language pair

File Progress Bar

Monitor the percentage of work completed on a file

Project Progress Bar

Monitor the percentage of work completed on a project

You can use filter criteria and sort files using the provided search options.

Item

Description

Files

Field to enter file filter criteria

Word Count

Column for total word count of file

Translation Status

Column contains status of pending, active, delivered, or completed

Complete

Column contains the file progress bar with completion percentage

Last Saved

Column contains the date for when the user most recently saved the file
Clear filter criteria
Sort filter criteria in ascending or descending order
Select a column on which to sort the filter list

TXLF Editor View
When you select a single file for review and open it, you launch the TXLF Editor view under the Review tab. This
is your default review and edit workspace.
Right-click anywhere in the source or target segments to access the TXLF Editor Context Menu.
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4. Explore the User Interface
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Item

Action

TSR Menu

Access the Current Project or TXLF Editor views and user preferences
Best Practice: Exit TransStudio is the only recommended method for
closing the application. Potential confusion and system errors may arise
from simply closing the browser window or clicking the browser's back
button.

File Name Tab

Use to view an open or chained file

Menu Tab

Use to access a specific function and its action buttons

Action Button

Use to perform a task

Action Bar

Access all action buttons associated with a specific tab

Table Filter

Use to filter criteria and or search in the open file
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Item

Action

Collapsed Items

Use to access any remaining tools that do not fit in the current, sized
window

Editor Pane

Use to access editor tab content or interact with it using menus and
submenus

Source Segment Column

View numbered, color-coded segments after source file analysis

Target Segment Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM)

Segment Score Column

View the TM match score represented as a percentage

Terminology Pane

Use to search the source or target glossaries or add terms to terminology
glossaries, if enabled

Status Column

View the status of a segment

Verification Column

Use to verify and commit a segment using the green checkmark

TXLF EDITOR VIEW

Filter Criteria
Use filter criteria to constrain searches of segment content.

Option

Function

Source or Target

Select from drop-down menu to search source or target segments

Match Case

Make your search case-sensitive

Regex

Select from drop-down menu to search on regular expression or wildcard
characters

Filter

Select from drop-down menu to constrain search even further
Activate the filter action
Clear the cumulative filter action
Reset the toolbar filter fields

Sort

Select from drop-down menu to order the remaining search list

Filter Configuration gear

Set the maximum segment filter word count

TXLF EDITOR VIEW

Segment Status
You can quickly identify the status of a segment in the TXLF Editor view by its status icon.
Status Icon

Segment Status
A non-linguistic error has occurred in the segment during a Transcheck test
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Segment Status
The segment is locked, so you cannot edit it
The segment is unconfirmed, so you cannot commit it to the translation memory
The segment repeats more than once in the current file
There is segment information available
The segment has a note associated with it
The segment has been graded and scored

TXLF EDITOR VIEW

Progress Bar
Once you have begun translation work, TXLF Editor registers progress at the bottom of the window.

Item

Action

Segments

View the number of segments completed versus the total number of segments

Segment (Src/Tgt/Max)

Check the number of characters in a source segment and the target segment,
followed by the maximum number of characters allowed in the target segment
Note:
The Max segment value turns red when it exceeds the maximum allowed.

Paragraph (Src/Tgt/Max)

Check the number of characters in the source paragraph and the target
paragraph, followed by the maximum number of characters allowed in the target
paragraph
Note:
The Max segment value turns red when it exceeds the maximum allowed.

Word Count Progress Bar

View the percentage complete and the number of words remaining
Note:
The percentage complete will not progress if the target segment is empty, or if
you have not modified machine translated or fuzzy segments. To progress to the
next unedited or MT fuzzy segment, either use the Verify Segment action on the
Translation tab or use the green checkmark in the Verification Column. Use the
Recalculate Progress action button on the File tab to update the progress bar
for files created or edited in legacy versions.
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Help and Feedback
HELP AND FEEDBACK

Help
Access online help by selecting the Online Help action button on the Help tab. If you still have questions after
reviewing online help information, email GlobalLink Support at support@translations.com.
Do not submit requests for changes to the software using Online Help.

HELP AND FEEDBACK

Feedback
For software issues only, click Feedback. Be as specific as possible, providing the exact steps you took when the
issue occurred.
Do not submit questions related to software usage to Feedback.
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5. Review Files
Once the translator has completed the translation, you can review the translated file in TXLF Editor. After
completing the review, save the file directly to Project Director. This updates the translation memory (TM).

Review a File
After you open a project, access project files from the Project Files tab. If the project has numerous files, you can
chain them together into one continuous file.
For users who interact with Captive TransStudio, this process is different. For more information,
review the most recent Captive TransStudio Quick Reference Guide.
To review a file:
1. In the TXLF Editor view, double-click the file or select a file, then click Review File on the Project Files tab.

2. Review the source segment and the target translation, then make changes to the Target segment as needed.
Verify that all tags in the Source segment are in the same location within the Target segment.

3. For those segments requiring modification, enter your explanation or comment in the Comments & Ratings
column.
This step can be mandatory or optional, depending on settings. For projects with mandatory
comments and ratings, a system notification displays. You must accept this notification before
proceeding to your review. A red border in the Comments & Ratings column indicates it is
mandatory and TSR does not allow you to complete the file without entering a comment and rating for
every segment you changed.
4. (Optional) For those segments requiring modification, click Add New Rating and select a rating type from the
drop-down menu in the Comments & Ratings column, then click Value and select a rating score value from
the drop-down menu.
5. Click Next Segment or press Alt+

to update the TM and move down one segment.

Save your work often by pressing Ctrl+S or clicking Save on the File tab.
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Chain Files
To combine multiple files and view them as a single file, use Chain Files. For example, if you are reviewing ten
files with ten segments each, you can temporarily chain them into a single file of 100 segments.
You cannot export or save chained files as a single TXLF file. Refer to Get a Bilingual Table to
download the chained files as a single document.
You can open and work on a single chained file or multiple sets of chained files in the TXLF Editor
view. Each chained file displays on its own tab.
To chain files:
1. On the Project Files tab, select a set of files, then click Chain Files.

The chained file opens in the Translation tab with a default file name of Chained Files 1. Each file in the
chain starts with a segment ID of 1 and ends with a file divider. Each segment in the file retains a sequential
number located in the ID column and also retains a distinct background color.

2. Click in a segment.
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5. Review Files
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The file name changes from the chained name to the source file name of the active segment.

3. Review and edit each segment.
4. Click Save on the File tab to save the chained file.
The software saves the segments in the chained file. It then restores the segments to their original files and
does not retain the chained format.

Comments and Ratings
Add Comments & Ratings during the review process on the TXLF Editor Review tab. This provides a valuable
tool for evaluating the quality of translation. As a reviewer, you can add Comments & Ratings when editing a
segment as a means to categorize the type of edit, then score the severity of edit. As necessary, add additional
information in the comment field.
The project determines whether Comments & Ratings are optional or required. When Comments & Ratings are
required, use the Comments & Ratings column for each segment you edit.
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5. Review Files
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COMMENTS AND RATINGS

Add Comments and Ratings
To add a comment and rating to a segment:
1. Edit the target segment, then either click in the Comments & Ratings column cell to open the Comment field
or click Comments & Ratings on the Review tab.

For projects with required comments and ratings, a red border displays around the Comments &
Ratings for the edited segment. In this case, you must complete comments and ratings for each
changed segment before you complete the file.

2. Enter a Comment for the edited segment and press Enter.
3. Click Add a Rating to select a grade from the Grade drop-down list, then select a score from the Score dropdown list.
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5. Review Files
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The comment and rating displays in the Comments & Ratings column and TSR adds a star to the Status
column.
COMMENTS AND RATINGS

Delete a Comment and Rating
To delete a comment and rating:
1. Select a segment, then either click in the Comments & Ratings column cell or click Comments & Ratings.
2. Identify which rating or comment to delete.
a) Delete a rating—Click

next to the rating.

b) Delete a comment—Select the comment text and press Delete or Backspace.

Find and Replace Content
Use Find/Replace to search for and replace text in translated content.
To find and replace content in a file:
1. In TXLF Editor view, click on the Edit tab.
2. Click Find/Replace.

3. In the resulting Find/Replace dialog, click in the Find what field, then enter your search text.
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®
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and

to expand and collapse the panel for additional options.

Search text can include non-breaking spaces.

5. Click Find Next to move through all instances of the content.
6. (Optional) Click Reading Highlight to highlight all instances of the content in all open files.

7. (Optional) To replace characters or words, click the down arrow on the sidebar, then click in the Replace with
field and enter the proper characters.

8. (Optional) Select the direction of the search and any further options.
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Option

Action

Backward

Search from cursor location to file beginning

Forward

Search from cursor location to file end

Ignore Case

Search for all instances of a word or phrase ignoring case

Whole Words Only

Search for all instances of only whole word matches
Note: Adding multiple words or punctuation disables this checkbox.

Ignore Non-breaking Space

Search for all instances of non-breaking spaces

Search Source

Search for all instances of a word or phrase in the source only

Search Target

Search for all instances of a word or phrase in the target only

Search Through Open Files

Search for all instances of a word or phrase in all open files

9. (Optional) Click on the applicable button.
Button

Action

Replace

Replace the found content only

Replace All

Replace all instances of that content

Find Next

Move to the next instance of the content

Close

Exit the dialog

Recalculate Progress
Use Recalculate Progress to calculate and update the progress of translated files, particularly files created or
edited in legacy versions. When you open a legacy file, the progress bar contains the N/A flag to denote that it will
not calculate progress. Use the recalculate action to update the progress and word count.
Refer to Chain Files to recalculate progress of multiple files.
To recalculate progress of a file:
1. Click Recalculate Progress.

2. Verify the progress bar reflects the current status of the file.
The progress updates to reflect the current % Complete status of the file.
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Save a File
To save your work:
1. Determine you have progressed with your translation or review work to a point where you want to save what
you have done.
2. In TXLF Editor, click one of the Save Options.

Save

Save the active file to PD.

Save All

Save all open files to PD.

A pop-up progress bar displays. After successful completion, the save action updates the file in Project
Director.
Saving the file does not complete the translation!
3. Continue with any other translation or review work. When you have finished all translation or review work for
that file, it is time to complete the file by following the instructions in Complete a File.

Complete a File
After you have finished all translation or review steps and have saved the file, complete the file and return it to
Project Director (PD).
This action is not reversible. You cannot reopen a file to make more modifications once you have
completed the active file. Completed files return to PD. Once the entire submission is complete, it
progresses to the next workflow phase.
To complete a file after translation or review:
1. In the TXLF Editor view, click Complete or Complete All on the File tab.
Complete

Complete the active file and update the status in PD

Complete All

Complete all open files and update the status of each open file in PD

2. On the Complete confirmation dialog, click Yes to complete your work.
The saved and completed file returns to PD and moves to the next step in the workflow.
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6. Project Files
When you open TransStudio Review for a project with multiple files, the default Current Project view lists all
projects you can open. Once you open a project, the files associated with the project display below the language
pair on the Project Files tab.

Run a Transcheck Report
Use Transcheck Report to verify target segments and flag a variety of common errors within segments. Run a
Transcheck Report on one or more languages or files in a project.
If you have specific terms you want Transcheck to ignore, you can mark those segements for
exclusion in the Transcheck Report using the Transcheck All action. This reduces false positives
during Transcheck error detection. Refer to Use Transcheck All.
To run a Transcheck Report:
1. Click Transcheck Report on the Project Files tab.

2. On the Project Transcheck dialog, select one or more languages or files.
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3. Select the Transcheck Tests you want to conduct.
Consistency checks are only accessible through the Project Transcheck dialog.
1. Source consistency check—Use to search for segments with the same target translation but
with different source segments.
2. Target consistency check—Use to search for segments with same source segments but with
target translations.
Select the appropriate checkbox to ignore differences such as, case, numbers, tags, and whitespace
to check consistency in source and target files.
4. (Optional) If you want to enable the Terminology Check or Blacklist Check tests, select the location of the
Glossary or Blacklist you want Transcheck to use from the list on its tab.
5. Click Run Transcheck.
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The application creates a Report Summary and the report opens in a new browser tab.

Conduct a Bilingual Export
Use Bilingual Export to export the TXLF file with highlighted glossary terms into a DOC format and edit it using
Microsoft Word.
Bilingual exports require you to set Bilingual Export Options in General Preferences.
To conduct a bilingual export:
1. On the Project Files tab, select a file or multiple files, then click Bilingual Export.

You cannot select files that are already open for Bilingual Export in the TXLF Editor. If glossaries are
available, the exported document will have highlighted source terms and target terms in comments.
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TransStudio downloads the bilingual exported file directly to the default download folder.
2. (Optional) Open the bilingual export file and review the results.

Generate a Segment Changes Report
A segment changes report provides you with the history of changes to a segment. The report includes the
segment ID, TM score, source and revised content with the highlighted changes, username, time stamp, edit
distance, ratings, and reviewer comments. You can run a segment changes report on one or more project files.
To generate a segment changes report:
1. Select a single project file or multiple project files, then click Segment Changes Report.

2. In the resulting Segment Changes Report dialog, select the languages or files to include in the report.
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3. Click Export.
Two separate entities open: the Segment Changes Summary and the Segment Changes Report.
4. Review the resulting Segment Changes Summary and click OK.

5. Review the resulting Segment Changes Report in your browser.

Copyright © 2018 Translations.com, Inc.

Confidential

Page 31 of 82

6. Project Files

Copyright © 2018 Translations.com, Inc.

®

GlobalLink TransStudio Review

Confidential

Page 32 of 82

7. Preview and Download Options
The Preview and Download options available on the File tab are used to preview files during translation or review,
and download additional resources for reference.

Get a Bilingual Table
You can preview and save the file you have open for translation as a bilingual table in Word format.
To get a bilingual table:
1. Select a file with some translated content, and on the File tab, click Get Bilingual Table.

The file downloads as a Microsoft Word document.

2. (Optional) Review the resulting file for completeness.

Copyright © 2018 Translations.com, Inc.

Confidential

Page 33 of 82

7. Preview and Download Options

®

GlobalLink TransStudio Review

Preview a File
Use Preview to display the source content in its original format, such MS Office, HTML, InDesign, and SDL
source formats.
To preview files:
1. Select a file with some translated content, and on the File tab, click Preview.

2. Select a Preview option.
Option

Action

InDesign Preview

Preview InDesign IDML source TXLF files, but not IDML source TXML files or any
other TXLF files. This preview does not dynamically update. To view additional
changes, generate a new preview.

Office Preview

Preview all MS Office files, including Word, Excel, and Powerpoint.

Open With Translation

Preview file with completed translation.

Open Without
Translation

Preview file in the original source format and language.

SDL Preview

Preview files containing SDLKC attribute.

HTML Preview

Preview HTML and HTM files.

Live Preview

Display a dynamic, live preview of the translated file.

The preview of the source content displays.

Live Preview
Use Live Preview to generate a dynamic preview of the translated file in TXLF Editor. Live Preview only works
on source MS Word DOC and DOCX files or on MS PowerPoint PPT and PPTX files.
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To generate a live preview:
1. Select a file with some translated content on the File tab, click Live Preview, then click Preview from the
drop-down menu.

2. (Optional) Interact with the live preview of the file.
For MS Word files
The preview pane docks to the right. Click for
docking alternatives to the default. Live Preview
highlights the active segment. Navigate to any other
segment by clicking on that area of the live preview.

For MS PowerPoint files
PowerPoint files can be graphically intensive and
so may take time to load. A loading progress bar
appears at the bottom. Click to cancel the Live
Preview.

•

Docking—The preview pane docks to the
right. Click for docking alternatives to the
default. Live Preview highlights the active
segment. Navigate to any other segment by
clicking on that area of the live preview.

•

Slide Navigation—Click the forward or back
arrow to progress through the slide deck or
type the deck slide number in the Page field.
To return to the first slide in the deck, click

.

3. Enter the translation or leverage the TM for any segment, then click Next Segment on the Translation tab or
press Alt-Down.
The new translation displays. To collapse or expand the live preview pane, click

or .

4. (Optional) Click Synchronize Live Preview on the File tab to refresh the pane and return to the top of the file.
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Download Reference Files
To download reference files, you must first configure the project in Project Director to support reference file
downloads.
To download reference files:
1. Open a file in TXLF Editor.
2. Click Download Reference Files.

3. In the resulting Download Reference Files dialog, select files and click Download.

The reference files download as a ZIP to the local Downloads folder.

Download Source Files
To download source files, you must first configure the project in Project Director to support source file downloads.
To download source files:
1. Open a file in TXLF Editor.
2. Click Download Source Files.

3. In the resulting Download Source Files dialog, select the files and click Download.
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The source files download as a ZIP to the local Downloads folder.

Show Instructions
When working with a translation submission created in Project Director (PD), you can add or review specific
instructions related to the submission.
To view instructions:
1. Open a file in TXLF Editor.
2. On the Files tab, click Show Instructions.

3. In the resulting Instructions dialog, review the instructions on the first tab and click Background Instructions
for any project-related or more general information.
4. Click OK.
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8. Translation Memory
Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

TM Color Codes
Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions (95-75%), or no match. Your organization may
choose to alter or add more fuzzy repetition categories. TransStudio highlights each segment to identify the type
of TM match.
Color

Category

Yellow

Indicates a fuzzy match.

Grey

Indicates there is no TM match.

Green

Indicates a 100% match.

Dark Green

Indicates a context match. A context match for a segment must meet one of the
following criteria:

•
•
•

The segment has a correct checksum or attribute match.
The previous and next segments also have a 100% match.
The 100% matched segment is a single paragraph.

Pink

Indicates a modified segment.

Purple

Indicates an update to the TM for a modified segment.

Light Purple

Indicates the update to the TM of a translated and committed segment automatically
updates other repetitive segments within the translation.

Light Pink

Indicates the segment was a machine translation (MT) instead of a human translation.

Conduct a Concordance Search
A concordance search looks for specific source segment text in a translation memory (TM). To view concordance
search results for both source and target segments, use the TM Lookup tab in the Editor pane.
To conduct a concordance search:
1. Click the Translation tab, then select a word or phrase in the segment in TXLF Editor.
2. Click Concordance Search.
You can also search for a word or phrase within the content by entering it in the TM Lookup field.
Then, to conduct a search of both source and target, press Enter. To conduct a more specific search,
click Find Source or Find Target.
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You can reorder the columns of the TM Lookup results. That reorganization remains, even after you
exit the software.

3. (Optional) To even further refine the search, select More Options and select a checkbox from the drop-down
list.
Option

Action

Case Sensitive

Filters by upper and lower case

Exact

Filters for only those terms organized in the same sequential order

Automatic Leverage

Automatically updates target content when navigating to a new segment

Diff Highlight

Highlights the difference between the submitted segment and the TM source
segment

Include Private TU (GLTMS) Includes private segments or translation units (TUs) when searching a remote
GlobalLink TM Server

View TM Leverage Results
Translation Memory leverage searches occur automatically you navigate through the segments. This provides you
with the best possible segment matches from the TM and is the only search that uses scoring to select the best
match.
To view TM leverage results in TM Lookup:
1. In TXLF Editor, click on a source or target segment.
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This populates the columns on the TM Lookup tab and provides a score, based on TM leverage results.

2. Review TM leverage results in each TM Lookup column for that segment.
Item

Action

Source

Displays source segments provided by the TM. If there is a difference between the
submitted version and what is already in the TM, the software highlights the segment.
The green highlight is the current version and the red strike-through highlight is the
version already in TM.

Target

Displays target segments already in the TM.

Score

Displays a TM leverage score.

•
•
•
•

Percent (%)—100% and fuzzy matches
Plus (+)—Context matches
Asterisk (*)—Secondary TM match
Red outline—TM has assessed a penalty to the segment

Refer to TM Color Codes for more information on TM color codes.
TM Name

Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the
TMs in order of priority: primary, then secondary TMs.

Creation Date

Identifies the TM segment creation date.

Creation User

Identifies the username of the segment creator.

Last Modified

Identifies the date of the last segment modification.

Modification User

Identifies the user who last modified the segment.

Custom Attribute

Identifies any segment custom attribute name and its associated values

Status

Acts as a button to access score breakdown information, including penalties.

3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the
columns you want to hide.
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9. Terminology List
Terminology lists include source terms and their preferred translations for the open source file.
When you select a segment, TransStudio highlights all terms within that segment that are in the terminology list or
glossary and displays the translation in the Terminology pane.
There are two possible navigation options when using the Terminology pane.

•
•

Click Next Term or Previous Term.
Press Ctrl+8 or Ctrl+9.

Terminology Color Codes
Projects connected to a terminology list or glossary highlight matches against the terminology list or glossary and
use various colors to represent the type of translation match.
Use Highlight All Terms to view highlights for term matches in the open file.
Source/Target

Target Exact Match

Target Fuzzy Match

Target No Match

Source Exact Match

Green/Green

Green/Yellow

Red/No color

Source Fuzzy Match

Yellow/Green

Yellow/Yellow

Purple/No color

Add a Term
You can only add terms to a remote glossary. To add terms to a remote glossary, you need read and write user
permissions. You cannot add terms to a read-only glossary.
To add a term to a glossary:
1. In the Terminology pane, select a word in the source segment and, optionally, the translation in the target
segment, then click

.

2. In the resulting Add Term dialog, enter content in the Description field.
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3. Select the proper Glossary from the drop-down list.
4. Click OK.
The glossary retains the new term.

Insert a Term
To insert a term into the current target segment:
1. In TXLF Editor, click in the target segment at the place for term insertion.
2. Select the term to insert from the Terminology pane.
3. At the top of the pane, click

.

This inserts the term into the target segment at the selected location.

Copy a Term
To copy a term from the glossary into the current target:
1. In TXLF Editor, click a segment that contains glossary terms.
2. On the Terminology tab, click Previous Term or Next Term to select a source term.

3. Click within the target segment at the location where you want to copy the term translation.
4. Click Copy.

The translated source term copies to the target segment.

View and Copy a Synonym
To view and copy a synonym for a term:
1. On the TXLF Editor, select a source term in a segment that has a glossary term. Either click to select it or use
Previous Term and Next Term as your selection method.
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This highlights the source term and adds a broad border. Synonyms display in a temporary pop-up pane and
in the Terminology pane.

2. Click within the target segment at the location where you want to copy the term.
3. Click Copy.
An alternative is to select the preferred translated term from the Terminology pane. This also copies
the term to the target location.

The application copies the translated source term to the target segment.
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10. Tags
Tags help track of things such as the format for source content. They are not translated and they come in pairs:
an opening and a closing tag. Translated content retains the formatting of the source content, so even though
tags do not themselves need translation, they are an important component in the final translation. For this reason,
translations should retain the same tags and same location within a target segmentas the source segment.
With Transcheck enabled, a warning message results when you try to save a target segment with
missing tags.
TransStudio Review issues a warning if you try to save a segment with a missing tag or an open tag.
An open tag is part of a tag pair in the target segment that is missing its matching close tag. If you
choose to ignore the warning, it discards the offending tag in the target segment.

View Tags
To view tags:
Do not edit or delete tags.
1. Open a file in TXLF Editor on the Translation tab.
This displays source and the leveraged target content.
Use General Preferences>Tags to configure tags as full-sized or shortened.
2. View tags in the source segments. Tags contain numerals to indicate their order in the segment. For example,
the first tag in a selected segment contains the numeral

.

•

Red tags—Indicates the selected tag in a segment, such as

•

Purple tags—Tags to specify formatting, such as

•

Blue tags—Tags to specify non-formatting controls, such as

3. (Optional) Hover over a tag to view tool-tip information.

Copy a Tag
To copy a tag:
1. In TXLF Editor, open a file.
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The default Translation tab displays the source and the leveraged target content.
General preferences dictate whether tags are full-sized or shortened.
2. Select a segments with tags. When the selected segment contains tags, the first tag is red to indicate
selection.
3. Select a single tag or select the segment tags as a group.
4. Click Copy.
For a shortcut, drag the selected tag into the target segment or press Ctrl-Alt-Down.

The target segment, highlighted in pink, contains the copied tags.

Clear All Tags
To clear all tags:
1. Open a file in the TXLF Editor.
The source and the leveraged target content appear in the Translation tab.
General preferences dictate whether tags are full-sized or shortened.
2. On the Edit tab, click Clear All Tags to expand the drop-down menu.

3. Select Segment or Document.
Segment or Ctrl-Shift-V

Clear only the tags from the selected segment

Document

Clear all tags for the entire document
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A warning message asks you to confirm that you want to clear all tags from the open file.
4. Cick Yes.
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11. Notes Usage
You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.
Use the Notes tab in the Editor pane to view and manage project notes.
To quickly access Notes actions, right-click the segment and select a notes action from the resulting
pop-up menu.

View Notes
Notes appear in the Editor pane and retain the same ID as the related segment.
Segments with attached notes include the

icon in the Status column.

To view notes:
1. Open a file in the TXLF Editor.
2. Click the Notes tab in the Editor Pane, then view the notes for file segments.

Add a Note
To add a note:
1. Select a segment.
2. On the Review tab, click Add.

An alternative is to click the Notes tab in the Editor pane, then click Add.
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3. In the resulting Add/Edit Notes dialog, select the note Type and enter the information in the note field.

4. Click OK.
The note is saved and associated with the segment.

Edit a Note
To edit a note:
1. Select a segment with an attached note.
2. On the Review tab, click Edit.

An alternative is to click the Notes tab in the Editor pane, then click Edit.

Copyright © 2018 Translations.com, Inc.

Confidential

Page 49 of 82

11. Notes Usage

®

GlobalLink TransStudio Review

3. In the resulting Add/Edit Notes dialog, edit the note and click OK.
The modified note is saved and associated with the segment.

Delete a Note
To delete a note:
1. Select a segment.
2. On the Review tab, click Delete.

An alternative is to click the Notes tab in the Editor pane, then click Delete.

The note is no longer attached to the the segment and the notes icon disappears from the Status column.
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12. Translation Segments
When a file is converted to a translatable TXLF format, all complete sentences become separate segments,
often divided by formatting or punctuation. Segments may be sentences, words or numbers, depending on the
formatting of the source file. After you have saved the segment translations, the application commits the segment
translations to the translation memory. Translation memory leveraging reduces the time and expense of future
translations by automatically and consistently translating reoccurring words and phrases.

View Review History
The Review History tab is used to view the review changes in the currently open file. The history includes the
step or phase name, reviewer username, modified target, grading and scoring, comments, and the modification
date and time.

Commit to the TM
Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.
To update the translation memory:
1. In TXLF Editor and on the Translation tab, click Commit All to commit all segments in the file to the TM.
If you want to commit a single segment to the TM, first select the segment, then click Commit.

2. (Optional) Verify that the updates you committed to the TM are now highlighted in purple.
3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as
necessary until you have committed all translated segments to the TM.
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Verify a Segment
Use the Verify Segment action to automatically modify and commit to a TM a 100%, fuzzy, or machine
translation (MT) match segment, if the segment does not require any further changes.
When you verify a segment, this automatically calculates the segment content into the total progress
for the file. Progress totals display in the progress bar completion percentage.
To verify a segment:
1. In TXLF Editor, scroll to a segment.
2. Either click

or click Verify Segment on the Translation tab.

This modifies the segment status to Edited and commits the segment to the TM, changing the highlight color
of the target segment to purple.

Copy Source Content
To copy source content to the target:
1. In TXLF Editor and on the Translation tab, select a source segment.
2. Click Copy Source.
As a shortcut, press Alt-S to copy the source content.

3. Select the desired copy action from the resulting drop-down menu.
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Option

Action

Copy Source

Copies from source to target all content and tags

Copy Source Text

Copies only content from source to target

Copy Source, Tags and Term
Translations

Copies from source to target all content text, its tags, and
translated concordance glossary terms

Copy Source and Term Translations

Copies from source to target all content text and translated
concordance glossary terms

Copy Source, Tags, Source and Target
Terms

Copies from source to target all content text, its tags, and both
source and translated concordance glossary terms

Copy Source with Source and Target
Terms

Copies to target all source and translated concordance glossary
terms

The specified source content copies to the related target.

Copy All Source Segments
To copy all source segments to all target segments:
1. In TXLF Editor and on the Translation tab, click Copy All Sources.

All target segments are the same as source segments.
2. (Optional) Begin translation in the target column.

Lock a Segment
You can lock segments once they are translated, confirmed, and proofread to prevent any further changes to that
segment.
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To lock a segment:
1. In TXLF Editor and on the Translation tab, select the segment to lock.
2. Click Lock Segment.

The Locked Segment

icon displays in the segment Status column to indicate the segment is locked.

Clear Target Segments
To clear target segments:
1. In TXLF Editor and on the Translation tab, select a target segment.
2. Click Clear Target.

3. From the drop-down menu, select Clear Target to clear the selected target segment or select Clear All
Targets to clear them all.
4. In the resulting Clear Current Segment Target dialog, click Yes to confirm you want to remove target content.

Unconfirm a Segment
Translators can temporarily mark a segment that should not be committed to the translation memory (TM) using
the Unconfirm/Confirm action. This allows translators to temporarily mark the segment, later refer to translation
resources, make any changes, and then confirm the translation for that segment based on that research.
To unconfirm a segment:
1. In TXLF Editor and on the Translation tab, enter a translation or leverage the translation memory for a target
segment.
2. Determine the segment requires further research prior to committing the translation to the TM.
3. Click Unconfirm/Confirm.
As a shortcut, press Alt+Shift+Enter for unconfirm and Ctrl+Shift+Enter to confirm all segments.
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icon displays in the segment Status column.

4. (Optional) To later confirm the segment, click Unconfirm/Confirm again.

Accented Characters for Windows
The application supports accented characters for many language sets. The application discriminates between
accents combined with standard characters and autonomous ligatures.
The key combinations identified here are for use with Windows operating systems and do not pertain
to Mac OS.
Many accents combine with standard characters.
Accent

Sample

Key Combination

Notes

Acute

ó or Ó

Ctrl+', v
Ctrl+', Shift+V

' is the apostrophe key
v is a lower case vowel
V is an upper case vowel

Circumflex ô or Ô

Shift+Ctrl+^, v
Shift+Ctrl+^, Shift+V

v is a lower case vowel
V is an upper case vowel

Grave

ò or Ò

Ctrl+`, v
Ctrl+`, Shift+V

v is a lower case vowel
V is an upper case vowel

Tilde

ñ or Ñ

Shift+Ctrl+~, c
Shift+Ctrl+~, Shift+C

~ is the tilde key
c or C is a character, but only works with upper
and lower case N, O, or A

Umlaut

ö or Ö

Shift+Ctrl+:, v
Shift+Ctrl+:, Shift+V

: is the colon key
v is a lower case vowel
V is an upper case vowel

Other accents require incorporation with the individual characters, so are treated as a complete character.
Complete

Name

Key Combination

Notes

¡

Inverted exclamation
point

Alt+Shift+Ctrl+!

Press and hold all three keys simultaneously

¿

Inverted question mark

Alt+Shift+Ctrl+?

Press and hold all three keys simultaneously

ç or Ç

French C cedilla

Ctrl+, , c
Ctrl+, , Shift+C

Press Control and the comma key, release both
keys, then press C or press and hold Shift+C

Character
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Name

Key Combination

Notes

œ or Œ

OE ligature

Shift+Ctrl+&, o
Shift+Ctrl+&, Shift+O

Press and hold Shift+Ctrl+&, release the keys,
and press O or press and hold Shift+O

ß

German sharp or
double S

Shift+Ctrl+&,s

Press and hold Shift+Ctrl+&, release the keys,
and press S

ø or Ø

Nordic O slash

Ctrl+/, o
Ctrl+/, Shift+O

Press and hold Ctrl+/, release both keys, and
press O or press and hold Shift+O

å or Å

Nordic A-ring,
Angstrom sign

Shift+Ctrl+@, a
Shift+Ctrl+@, Shift+A

Press and hold Shift+Ctrl+@, release the keys,
and press A or press and hold Shift+A

æ or Æ

Old English AE ligature Shift+Ctrl+&, a
Shift+Ctrl+&, Shift+A

Press and hold Shift+Ctrl+&, release the keys,
and press A or press and hold Shift+A

ð or Ð

Icelandic or Old English Ctrl+', d
eth
Ctrl+', Shift+D

' is the apostrophe key
Press and hold Ctrl+', release both keys, and
press D or press and hold Shift+D

Character

To insert accents or accented characters:
1. (Optional) To enter a character that combines with an accent, follow the key combinations in the accent table.

•
•

For example, to create an A with an acute ligature, hold down the Control key and press the apostrophe
key. Release both keys and either press A or press and hold Shift+A.
For example, to create an O with the grave ligature, hold down the Control key and press the
apostrophe key. Release both keys and either press the O or press and hold Shift+O.

2. (Optional) To enter a complete accented character, follow the key combinations in the complete character
table.

•
•

For example, to create the inverted exclamation point, press and hold Alt+Shift+Ctrl+! and then release
all keys.
For example, to create the œ ligature, first press and hold Shift+Ctrl+&, then release the keys and
either press O or press and hold Shift+D.

Copyright © 2018 Translations.com, Inc.

Confidential

Page 56 of 82

13. Use Transcheck
Use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets, numbers,
and terminology within target segments. It posts a warning icon in the Status column for that segment if it locates
one or more errors.
To enable Transcheck and customize Transcheck options, configure in Current Project
Preferences.
If you have specific terms you want Transcheck to ignore, you can mark those segements for
exclusion in the Transcheck Report. Taking this action, this will reduce false positives during
Transcheck error detection. Refer to Run a Transcheck Report.
With Captive TransStudio, users are only allowed to perform Transcheck and review Transcheck
Summary results. There is no option for running a Transcheck Report.

Transcheck During Translation
After you have configured Transcheck options, you can begin using Transcheck during translation. The
Transcheck segments while translating option checks for errors during the translation process. When you
translate a segment and commit to the TM, a Transcheck warning immediately pops up if there are any errors,
assuming you have configured your Transcheck options to include this action.
To use Transcheck while translating:
1. In TXLF Editor, click a segment and complete your translation of that segment.
2. Click Next Segment or Alt-Down.
3. (Optional) If Transcheck identifies an error in the segment, it posts a warning message.
Click Go back to fix the issue to correct the error

•
•

Click Continue to continue translating without changes
If you do not correct the error, the

icon remains in the Status column and on the Transcheck tab.

Use Transcheck All
Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issues
warnings for missing and incorrect text. Use the Transcheck All option before you complete a file.
To use Transcheck All :
1. In TXLF Editor, finish translation of all segments in a file.
2. Click the Review tab, then click Transcheck All.
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A Transcheck report and summary result.
3. In the resulting Transcheck Summary dialog, review the warnings, then click OK.
The Transcheck Report browser window is displayed.
4. (Optional) In the resulting browser window, determine which terminology errors you would like Transcheck to
ignore from highlighted terms in the Terminology Check report section.
To best optimize the Transcheck Report, you can have the application ignore highlighted terms you
identify under conditions you specify. The terms and conditions you select appear at the top of the
report in the Ignored Terminology Errors section.
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5. (Optional) Click on a highlighted term.
6. (Optional) In the resulting Ignore Terminology Transcheck Error dialog, compare the source string with
the resulting equivalencies, then select either When term is for source terms in the glossary or When target
contains for target terms.
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7. (Optional) Either click Ignore to ignore only the single instance of a string or Ignore All to ignore every
instance of a string. The number following Ignore All contains the total number of instances within that file.

8. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.
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9. (Optional) After closing the Transcheck report, click on any remaining segments with a Transcheck error
icon in the Status column.
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10. (Optional) Click the Transcheck tab to examine the details of the segment error.
The number in parentheses next to the Transcheck tab title indicates the total number of errors found
in the segment.

11. (Optional) Click Next error on the Transcheck tab to navigate to the next segment error , or click Previous
error to review errors in the content prior to your current location.
12. Either correct the error and click Refresh to complete the correction, or click Ignore warning to continue
reviewing error warnings without making any changes.
If you do not correct the error, the
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You user preference options control the functions available to you in the user interface. Configure preferences at
either the project level or at the file level.

Access User Preferences
To access user preferences:
1. On the Edit tab. click Preferences.

2. Configure preferences under the two primary categories: General Preferences and Current Project
Preferences.

General Preferences
Use General Preferences to configure user interface and TXLF Editor preferences.
GENERAL PREFERENCES

Configure Color Settings
Colors preferences control color customization for specific types of content in TXLF Editor.
To configure colors used in the translation table:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Colors under General Preferences.
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3. Click the color box for any Item Name, then select another color from the color palette in the resulting Color
Picker dialog.
4. Click OK to close the Color Picker dialog.
5. (Optional) Click OK to close the Preferences dialog.
GENERAL PREFERENCES

Configure General Settings
General preferences link a specific username to project-related content changes.
To customize general settings:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click General under General Preferences.
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3. Select one of the source file locations.
Option

Action

Copy Source or TXLF Files into Project
Folder Structure

Creates a sub-folder within the project language folder for storing
source files.
Note: If the source file is a TXLF file, the tool stores a copy.

Create TXLF File with language suffix
next to the Source File

Creates a TXLF copy of the source file at the same location with
the target language code as a suffix.
Note: If the source file is a TXLF file, the tool stores no copies.

Create Folder with language suffix next Creates a TXLF copy of the source file in a sub-folder at the
to the Source File where TXLF file will
source file location with the target language code as a suffix.
be stored
Note: If the source file is a TXLF file, the tool stores no copies.
4. Select Add score column to bilingual table to add TM score to the exported bilingual table.
5. Select the Bilingual Review Export options that allows you to export the TXLF file with highlighted glossary
terms to a DOC format and edit using Microsoft Word.
Option

Action

Open report after export

Automatically open the Bilingual Report after the export
completes

Exclude the notes column

Exclude the notes column from the exported MS Word document
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Option

Action

Track changes

Enable or disable the track changes option in the exported MS
Word document

Protect document (Word 2003+)

Write-protect the document, allowing users to edit only the target
segment content and add notes
Note: The remainder of the document is read-only.

Export all TXLF files as one bilingual
file

Enable the bilingual export option in the Project view

GENERAL PREFERENCES

Configure Icon Settings
The Icons preference allows you to set the relative size of the icon and include or exclude the icon title.
To configure icon settings:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Icons under General Preferences.

3. Select a size for application icons.
4. Select Display text to include icon description text and click OK.
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GENERAL PREFERENCES

Configure Layout Options
The Layout preference allows you to modify the layout of the TXLF Editor view.
To configure layout options:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Layout under General Preferences.

3. (Optional) Modify the Custom Action Bar.
Advanced

Select to provide users with tools functionally grouped within eight
tabs

Simple

Select to provide users with tools functionally grouped within the
two Review tabs

4. (Optional) Modify the Table View.
Hide ID Column

Select to hide the segment ID column

Hide Score Column

Select to hide the translation memory (TM) score column

Hide Table Header

Select to hide the editor table header

5. (Optional) Modify the Score Column Position.
Before Target
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Place the TM score column after the target segment column

6. Click OK.
GENERAL PREFERENCES

Configure Segment Actions
The Segment preference allows you to configure the segment behavior in TXLF Editor.
To configure segment actions:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Segment under General Preferences.

3. Select a segment option.
Option

Action

Next/Previous Segment action
leverages next/previous segment

Enable or disable the writing and leveraging action of the
command.

Open last edited segment when
opening a file

Go to the last segment edited when a file is opened.

Leverage the first opened segment
on click

View the Translation Memory leverage of the first open segment
when you open a TXLF file for translation.

Capitalize the first letter of the target Translated segment are converted to sentence case, but not for
segment (Except Asian Languages) Asian languages.
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Option

Action

Enable Smart Quotes

Changes the quotation marks to smart quotes. Depending on the
target language, the quotation marks used when the user presses
the quotation mark keys on the keyboard are changed.

Skip Unedited 100% Matches

Enable or disable skipping over 100% matched segments.

Skip Unedited Context Matches

Enable or disable skipping over those segments with context
matching.

GENERAL PREFERENCES

Customize Keyboard Shortcuts
The Shortcuts preference allows you to customize key combinations as keyboard shortcuts for the commands
you use most frequently.
To customize keyboard shortcuts:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Shortcuts under General Preferences.

3. Select a style Scheme from the drop-down list.
When changing or creating new shortcut key sequences, the sequence must begin with a Ctrl, Alt, or
Shift, or must be a Function key (F1) or, a combination of these.
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4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then
click OK.
If you choose a shortcut key sequence already in use, the application issues a warning that it will override the
prior key sequence. Click Yes to save the new shortcut for a command or click No to retain the prior shortcut.
This saves the new shortcut key sequence.
GENERAL PREFERENCES

Configure Warning Messages
The Warnings preference allows you to control the type of warning notifications you receive from the application.
To configure warning messages:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Warnings under General Preferences.

3. On the resulting Preferences dialog, select your warning notifications.
4. Click OK.
GENERAL PREFERENCES

Configure Tags and Formatting
The Tags preference allows you to configure the tag mode, representation, and font size in TXLF Editor.
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Projects created with GlobalLink Projects (GLP) in Project Director (PD) may not support formatting
tags.
To configure tag options:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Tags under General Preferences.

3. (Optional) Modify Text Formatting options.
Option

Action

Show supported text
formatting

When supported, displays actual formatting associated with formatting
tags.
Note: When enabled, it provides a preview of formatted content.

Show formatting as Tags

Displays the content of the formatting tags.
Note: After you enable this option, it also provides a preview of formatted
content.

4. (Optional) Modify Tag Naming options.
Option

Action

Full Name

View the tag's full name, for example Font.

Short Name

View the tag's short name, for example F.

Numbered Tags

View the tag's number, for example 3.
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Option

Action

Remove incomplete tag pairs

Delete incomplete or incorrect tags.

Apply source segment
formatting to target segment

Apply the segment formatting from the source segment within a tag to the
target segment.

GENERAL PREFERENCES

Configure Auto-Propagation
The Auto-Propagation preference allows you to leverage repetitive segments and re-use content.
To configure auto-propagation:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Auto-Propagation under General Preferences.

3. Select Enable Auto-Propagation to activate additional auto-propagation options.
4. Select Enable Auto-Propagation across all open files to apply auto-propagation to all files that are open.
5. Review the Auto-Propagation options to verify the required options are the only ones selected.
Option

Action

Context matches

Overwrite context leveraged translation memory (TM) matches

100% matches

Overwrite 100% leveraged TM matches

Fuzzy matches

Overwrite partial TM matches
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Option

Action

Auto-propagated
matches

Overwrite all auto-propagated matches
Note: If there are multiple segments that have the same content, editing a
segment auto-propagates the change to all matching segments.

Edited segments

Allow the overwrite of edited segments using Auto-Propagation
Note: This allows the overwrite of edited segments.

Machine translated
segments

Overwrite machine translated content

Committed segments

Overwrite translated content that is committed to the TM

GENERAL PREFERENCES

Configure Auto-Suggestion
The Auto-Suggestion preference populates suggestions based on source content, such as numbers, URLs, and
proper names. It can also suggest terms for the glossary, Translation Memory (TM) matches, and Sub-segment
TM matches.
To configure auto-suggestion:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Auto-Suggestion under General Preferences.

3. Select the Enable Auto-Suggestion checkbox and suggestion options, then click OK.
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Option

Action

Source

Select to have the application suggest changes to source of the segment:
numbers and capitalized words only

Glossary

Select to have the application suggest terms from the glossary

TM

Select to have the application suggest translations from the TM

TM Sub-Segment

Select to have the application suggest parts of segments from the TM

MT

Select to have the application suggest machine translation (MT) text

GENERAL PREFERENCES

Configure Machine Translation
The Machine Translation (MT) preference provides an automated action to populate the target segments with
translations that have no translation memory (TM) segment matches.
To configure a machine translation engine:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Machine Translation under General Preferences.
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3. Select one of the following:
Show MT results in TM Lookup when there is no TM match, to show machine translated content without

•
•

remote TM matches.
Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

4. Select checkboxes to allow All unedited segments in active document to be leveraged with MT, and to
Remove MT score from score column when segment is edited.
5. Select Google Translator, Microsoft Translator, or WorldLingo as the primary machine translator. You can
enable all three, but you can only designate as the primary machine translator.
6. Select MT options for each machine translator, then perform the designated setup tasks associated with each
machine translator.
WorldLingo has a limited set of source languages for MT.

•
•
•
•
•

Arabic
Chinese Simplified
Chinese Traditional
Dutch
English

Translator

•
•
•
•
•

French
German
Greek
Italian
Japanese

•
•
•
•
•

Korean
Portuguese
Russian
Spanish
Swedish

Options

Enable Google
Translator

Enable Microsoft
Translator
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Options

Enable WorldLingo
WorldLingo MT has a limited source language set.
7. Read the disclaimer and click OK.

New Project Preferences
New project preference options control whatever has been set up for this project by the Project Manager.
Settings begin with standard defaults.

NEW PROJECT PREFERENCES

Configure Terminology
The Terminology preference allows you to configure lists or glossaries to use for leveraging previously translated
text, which results in lower costs and greater consistency.
To select terminology options:
1. Select Preferences from the TransStudio Review drop-down menu.
2. Click Terminology under New Project Preferences.
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3. Select Enable fuzzy term recognition to view fuzzy matches.
4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when
entered in the translation.
5. Select Ignore case for term highlighting to ignore case difference in terminology matches.
6. Select the number of matches you can view, then click OK.
NEW PROJECT PREFERENCES

Configure TM Penalties
Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This
involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score is used to differentiate
between 100% match, fuzzy match, and no match content.
To select penalties for TM matches:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Penalties under New Project Preferences.

3. Select a penalty, supply a threshold, then click OK.
Penalty

Action

Case

Select to consider differences in case
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Penalty

Action

Non Literal

Select to consider differences in special characters, including punctuation, space,
apostrophe, dash, and quote

Tag

Select to consider differences in tagging

Whitespace

Select to consider differences in blank spacing

Align

Select to consider differences in translation units (TUs) with alignment attributes

Machine Translation

Select to consider differences in TUs based on machine translation (MT)

Multiple Translation

Select to consider differences in TUs based on duplicates within the TM with
different translations

Local TM

Select to consider differences in TUs from the local desktop copy
Note: TransStudio Online and TransStudio Review cannot access a local TM.

Remote TM

Select to consider differences in TUs from a remote TM

Private TU

Select to consider differences in work-group TUs from a remote TM

Public TU

Select to consider differences in non-work-group TUs from a remote TM

Secondary TM

Select to indicate that the translation leverages a secondary TM

Attribute

Select to consider differences in attributes

If attribute is not

Select for when a custom attribute in a TU does not match the text box attribute

If filename attribute
does not match

Select for when the file name attribute in a TU does not match the TXLF file name

NEW PROJECT PREFERENCES

Configure Transcheck
Transcheck preferences verifies target segments and issues warnings about common translation errors.
Transcheck configuration is specific to a given project. For example, if a tag is missing or there is incorrect text, a
warning symbol displays in the Status column.
To configure Transcheck:
1. Select Preferences from the TransStudio Review drop-down menu.
2. On the resulting Preferences dialog, click Transcheck under New Project Preferences.
There are primary Transcheck options, some of which provide additional sub-options.
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3. To control how Transcheckevaluates source and target segments, select different configuration settings.
Option

Action

Transcheck segments
while translating

Select to enable Transcheck during translation.

Select/Deselect All

Select to enable or disable all Transcheck options. To select only some
Transcheck options, continue down the settings list.

Blacklist Check

Select to identify terms in target segments that are banned from use the content.
Note: This option is available depending on the TMGR configuration for the
project.

Capitalization Check

Select to identify differences in capitalization, then select the appropriate
checkboxes.

•
•
•
•
•
•
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All Caps Mismatch—Identify text in the target that is all upper case, when
the source is not all upper case
First Word Case Difference Check—Verify the first letter of the first word
is capitalized consistently in source and in target
Target Capitalization Mismatch Check—Indentify upper case text in the
target that is in lower case in the source
Source Capitalization Mismatch Check—Identify upper case text in the
source that is in lower case in the target
Skip exact matches—Ignores capitalization on exact matches
Skip context matches—Ignores capitalization on context matches
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Option

Action

Edited Context Match
Check

Select to identify if there are edits to context matches from the TM.

Edited Exact Match
Check

Select to identify if there are edits to exact matches from the TM.

Edited Source Check

Select to identify if there are edits to the source of a segment.

Empty Target Check

Select to identify segments containing no translation.

Forbidden Character
Check

Select to identify target segments containing forbidden characters, such as the
tilda, asterisk, or ampersand.
1. Click Add, enter the forbidden character or character string in the column
1 field, then click Update.
2. Select whether you want to ignore exact matches or content matches.

Mistranslated Text
Check

Select to identify segments with common translation errors. This generates a
report that lists the correct and wrong usage of translated text.
1. Suppress noise—Remove redundancy from the reported warnings or
errors
2. Skip exact matches—Ignores common translation errors on exact
matches
3. Skip context matches—Ignores common translation errors on context
matches

Note Check

Select to identify and run a report of segments with notes. When you run
Transcheck while in TXLF Editor, every segment that has notes has a related
alert flag.

•
•
Number Difference
Check

Skip exact matches—Ignores notes on exact matches
Skip context matches—Ignores notes on context matches

Select to identify numerals in the source segment that match the target segment.

•
•
•

Treat numbers separated by hyphens and dashes as single number—
Ignores hyphenation and dashes separating numbers
Skip exact matches—Ignores numerals on exact matches
Skip context matches—Ignores numerals on context matches

Paragraph Length
Check

Select to identify target paragraph lengths that exceed the maximum character
length set for the paragraph.

Punctuation Check

Select to identify consistency in typical punctuation, such as commas or periods,
between source and target segments.
1. Click Add, enter the source punctuation mark in the column 1 field, the
target punctuation mark in the column 2 field, then click Update.
2. Select whether you want to perform a check on dual occurrences of a
punctuation mark, ignores exact matches, or ignores content matches.
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Option

Action

Repeated Word Check

Select to identify duplicated words in the translation.

•
•
Segment Length Check

•

Strict Character Length Check (Zero means unlimited)—Identifies

•

Character Expansion Check—Identifies violations of minimum and
maximum character expansion, as a percentage

•
•
•

Word Expansion Check—Identifies violations of minimum and maximum
word expansion, as a percentage
Attribute Character Max Length Check—Identifies violations of attribute
text that exceeds the maximum character length set in Project Director
(PD)
Skip exact matches—Ignores segment length on exact matches
Skip context matches—Ignores segment length on context matches

Skip exact matches—Ignores extended punctuation on exact matches
Skip context matches—Ignores extended punctuation on context
matches

Select to identify segments in the target that contains segments copied from the
source.

•
•
•
Spelling Check

violations of minimum and maximum character length

Select to identify consistency in less common symbols, such as copyright
symbols, trademarks, and bullets, between source and target segments.

•
•
Copied Source Check

Skip context matches—Ignores repeated words on context matches

Select to verify if the translation complies with preset limits on characters and
words.

•

Extended Punctuation
Check

Skip exact matches—Ignores repeated words on exact matches

Skip exact matches—Ignores exact matches of copied source content
Skip context matches—Ignores exact matches of copied source content
Skip tokens—Ignores software tokens within regular expressions in the
copied source, such as [-+_/\[\]()#:;.A-Z0-9]+

Select to check spelling as you enter the translation.
Note: If the spellcheck language is not available, a message notifies you that
Transcheck will continue, but the spellcheck does not take place.

•
•
Tag Check

Skip exact matches—Ignores spellcheck on exact matches
Skip context matches—Ignores spellcheck on context matches

Select to identify missing tags in the target segments.

•
•
•
•
•
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Check for non-formatting tags
Check for Source formatting missing in target
Check for formatting that exists in target but not in source
Skip exact matches—Ignores tags with exact matches
Skip context matches—Ignores tags with context matches
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Option

Action

Terminology Check

Select to determine if the terms in the source segment are translated correctly
based on the terms in the terminology list.

Unconfirmed Segment
Check

•

Enforce Term Case—Verifies the source text matches the exact case of

•
•
•

Fuzzy Term Check—Includes terms that approximately match the term

the term
Skip exact matches—Ignores terms with exact matches
Skip context matches—Ignores terms with context matches

Select tverify if the segment is marked unconfirmed.

•
•

Skip exact matches—Ignores unconfirmed exact match segments
Skip context matches—Ignores unconfirmed context match segments

Unedited Exact Check

Select to determine if exact matches were not edited.

Unedited Fuzzy Check

Select to determine if fuzzy matches were not edited.

Unedited MT Check

Select to determine if machine translated matches were not edited.

Untranslatable Text
Check

Select to determine if the content that cannot be translated in source and target
segments is consistent.
1. Click Add, enter the untranslatable content in the column 1 field, then click
Update.
2. Enter an untranslatable regular expression in the custom field.
3. Skip exact matches—Ignores exact matches of untranslatable regular
expressions .
4. Skip context matches—Ignores content matches of untranslatable
regular expressions.

Untranslated Text
Check

Select to determine if any segments are not translated. Typically, this occurs
when you copy the source into the target segment prior to translation, but missed
translating that segment.

•
•
Whitespace Check

Skip context matches—Ignores untranslated context match text

Select to identify mismatched or double white spaces in the target segment.

•
•
Download Transcheck
Configuration

Skip exact matches—Ignores untranslated exact match text

Skip exact matches—Ignores exact white space matches
Skip context matches—Ignores white space context matches

Select to save a copy of the completed configuration.

4. Click OK.
This reconfigures Transcheck for the current project.
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